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Background:

The University of Illinois Archives was founded in 1963.  The Archives currently includes
approximately 21,250 cubic feet of university records, manuscript collections, photographs and
other documents.  In addition to records and manuscripts related directly to the University, the
Archives holds records and manuscripts related to several professional organizations, including
the American Library Association, the Ad Council, and the 3rd Armored Division Association. 
Staff include 2 FTE faculty for University Archives, 1 FTE faculty (on endowed funds) for
student life and culture, and 1 FTE faculty (on restricted funds) for the Sousa Archives for Band
Research.  In addition, the University Archives employs 1 FTE civil service staff member
(Library Technical Assistant), a 1/4 FTE graduate assistant on university funding, and 1.5 FTE
graduate assistants on contract funding for associational archives managed by the University. 
An Archivist for Electronic Records is currently open.

The University of Illinois was one of the first (if not the first) academic archives to develop a
computerized archival automation system.  The first application was developed in 1971, and the
system was expanded between 1971-1981.  The development of the University's in-house control
system has been more fully described by William Maher,1 but the system's main features are
summarized here since the system design was subsequently reengineered and adopted into our
current systems and workflow patterns. The system consisted of four main parts, and the main



output of each part was printed reports or finding aids.
• The PARADIGM system ran on a mainframe computer and included several

related databases.  An authority control system (using locally developed terms)
was included.  The main outputs of the system were administrative reports and a
subject-based finding guide.  This database included only basic administrative
data such a record series numbers, titles, volumes, dates acquired, and the
inclusive dates of the series.

• CONTROL CARD system.  The main descriptive finding aids consisted of 5 x 8
inch typed Kardex cards containing record series number, title, volume,
description (scope and content note).  Eventually, these files were migrated to
electronic format.  WordPerfect 5.1 macros were used to produce printed cards.

• SUPPLEMENTARY FINDING AIDS.  For many series, a typed or word-
processed box and folder title listing was produced.

• LOCATION database.  Tracked locations for runs of boxes.  This was an R-Base
DOS application, and was used to produce printed reports.

From 1999-2001, these systems were migrated to an integrated electronic format running on
Microsoft SQL Server platform.  This systems is described in section 2 below.  

It should be noted here that the University Archives' entire classification and descriptive system
is built upon a Record Group, Subgroup, and Series numbering system, which carries through all
of our paper-based filing systems and electronic databases described below.  Major campus
administrative units have each been assigned a subgroup number, departments or smaller units
within the main unit have been given a subgroup number.  For example, the College of Liberal
Arts and Sciences is Record Group 15.  The History Department (a subunit) is subgroup 15/13. 
Each series of papers in the History Department has been assigned a series number (series 1 is
generally the subject file).  Personal papers are generally assigned to series 20 and higher. 
Publications are assigned a series number of 801 or higher.  Thus the History Department's
newsletters are series 15/13/807.  Records of Non-University organizations have been added to
this system on an ad-hoc basis.  For example the Advertising Council Archives are included
under the Advertising Department records, in a discrete run o series numbers.  Owing to its size,
the ALA Archives are included in a separate database, with a separate authority control system.

1.  Accessioning, Processing, and Access Workflow

Information gathering for both personal papers and official records begins before materials are
received in the archives. Generally, personal papers undergo appraisal by an archivist,
sometimes over a multi-year period of donor contacts.  As soon as initial contact has been made
with an archivist, a physical file folder is established in our pending acquisitions file.  The file
contains all correspondence (including printed copies of e-mail), lists, reports and other
information relating to the pending accession.  This file later become the basis for the descriptive
information entered into our database.  For larger collections, an archivist may visit the
individual whose papers are being considered for accession.  The archivist sometimes prepares a
hand-written inventory.  If possible, we secure a transfer list from the party—preferably in
electronic format— which is later edited and become the basis of our finding aid.  Contact
sometimes stretches on for months or years before the accession is actually received, so we see it



as imperative to keep all records in the physical file.

Official records come to us by several sources–cold calls from campus offices facing a space
crunch, active selection by an archivist, and orderly records scheduling activity.  Since the
archives is responsible for the University's records scheduling program, we maintain files
containing all approved records disposal authorizations (RDAs), as well as correspondence,
reports, and other materials relating to uncompleted records schedules.  These files sometimes
prove valuable in assessing the value of incoming records, and they have been indexed in a
standalone Microsoft Access database (see screen shot in Appendix 1).   The main output of this
database is a printed report, organized by record group and subgroup, which allows us to find
Records Disposal Authorizations on file for each campus office.  The RDAs are organized
chronologically.   In addition to the RDAs we keep administrative files for each department,
which are organized by record group and subgroup.   Correspondence and reports regarding our
direct contacts with the department are maintained.  Materials used in appraisal are stored here if
they have not been placed in the pending accessions file mentioned above—the procedure is
fairly fluid.

Our treatment of personal papers and institutional records does not vary in any material respect
after being appraised.  When materials arrive in the archives, an archivist or the LTA writes an
entry in our handwritten accession register.  The entry includes an accession date, provisional
series title, a provisional record group, subgroup, and (possibly) series number, the donor/source,
the volume acquired, a physical description (number and type of files or boxes), the location in
which it has been shelved while waiting processing, and "notes".  In addition, the archivist or
LTA usually completes an "inventory worksheet sheet" (IWS), which is attached to the records
or placed in the first box.  It contains basic data to identify and describe the series, such as
volume, number of boxes, source, etc.  At some later date, the entry in the printed accession
register is input (by the LTA) into our accession register database, which is a stand alone
Microsoft Access database.  See screen short in Appendix 2.

The material now sits on the shelf for a period ranging from days to decades.  Once it has been
targeted for processing, it is provided to our LTA, an archivist, or, most likely, a graduate
assistant.  The following workflow describes processing by a graduate assistant, since that is
most common scenaria.  The workflow does not vary much  when completed by an archivist,
expect the paper work does not go through an approval step.

Using the inventory worksheet and accession register information, the processor now completes
basic arrangement, refoldering and reboxing, removing paper clips, etc.  As necessary, the
processor refers to the archivist or to the information from the pending accessions file for
information needed to order the materials correctly.  When basic arrangement has been
completed, the processor prepares a word-processed box and folder listing, or edits the electronic
transfer list, if one was provided by the donor or transferring university office.  In its final
format, the finding aid looks like that attached in Appendix 3.  The processor then adds a
database entry to our SQL database using the form shown in Appendix 4, using information from
the pending accessions file if necessary.  The processor prepares a box label list, prints a draft
control card, and submits all paper work to his/her supervisor for approval.  After approval,
boxes are labeled and shelved, corrections made to the database entry and the finding aid.  The



details of this "end of processing workflow" are detailed in a handout (which is provided here in
Appendix 5).

If a collection is judged by the archivist to be important enough for EAD, processor then
completes EAD markup of the word processed document by converting the file to text, importing
it to NoteTab Pro software, and using our standard EAD markup protocol.  The NoteTab markup
interface is shown in Appendix 6.  No printed training materials exist; the process is more or less
automated using macros and requires minimal training.

If no EAD finding aid is to be done, a copy of the finding aid is posted to our website as a pdf
document, and is provided via a link from the database record shown on the website.

Access to the records is provided through our website and printed Kardex Control Cards and
printed in house finding aids.  All descriptive information, except location information, is now
provided via the Internet.  Location information is provided only on staff machines, as shown in
Appendix 7, to facilitate retrievals.  The architecture for this system is more fully discussed in
Section 4.  The database can be accessed at http://web.library.uiuc.edu/ahx/uaccard/. 

2.  Databases and Collection Management Tools

As mentioned above, we use databases and collection management tools during all stages of our
processing workflow. They are also integrated fully into our reporting functions, and I will
describe each of the systems in more detail:

• Accession Register Database.  This is used to record several pieces of
information; its main purposes include inventory control and reporting.  It is a
standalone Access database, and is used only by faculty and LTA staff. Its most
important function is inventory control, as it contains a variety of fields that can
be searched.  It is helpful in tracking the provenance of an accession, finding
misplaced accessions, etc.  In addition, a number of queries have been written to
report data such annual volume accessioned, current volume unprocessed, etc. 
These data are collated against data reported from our other databases and are
included in our Annual Report.  

• RDA file and database. All records disposal authorizations are filed
chronologically, and the RDA database helps us keep track of them. Also, an
annual report is run so that we can report the number and volume of series
scheduled for disposal or transfer to archives.  This database is updated on an
annual basis by an undergraduate assistant working under the supervision of the
assistant archivist.

• Control Card Database: This database is the successor to the PARADIGM,
CONTROL CARD, and LOCATION databases described in the background
section.  It is a Microsoft SQL Server database which consists of the linked tables
shown in Appendix 8.   The three fields RGNumber, SGNumber, and RSNumber
function as a primary key or control.  Staff access the database via an Access
form shown in Appendix 4.  User Documentation for the Database is attached in
Appendix 9; Technical Documentation is in Appendix 10.  The database is used



as the source for Active Server pages that run the user interface provided through
the Internet.  A link is provided to PDF or EAD version of detailed finding aids. 
In addition, the database serves as the basis for a number of administrative
reports.  Full details on the system architecture, reports, and much more can be
found in the Appendixes.  It should be noted that this database, as well as the
associated ASP pages were designed, implemented, and programmed almost
entirely by University Archives staff.

• Reference tracking.  Reference use is tracked manually.  Each time a reference
request is completed, archives staff complete a 3x5 card listing the information
shown on the card shown in Appendix 11.  At the end of the month, this
information is manually compiled by the LTA, and entered into a Quattro Pro
spreadsheet.   Reports of reference use on a monthly basis are produced, as well
as for the Annual Report.  Appendix 12 shows a portion of the report generated
by Quattro.  We also track webhits using an ASP application developed by our
systems office.

3. List of Database Fields:

Accession Database:
• Accession Date
• Title
• Record Group Number (linked to authority controlled names)
• Sub Group Number (linked to authority controlled names)
• Series Number
• New Series/Addition to existing series indicator (Y/N)
• University Archives or ALA Archives indicator (U/A)
• Volume Accessioned
• Donor/Source
• Unprocessed Volume
• Type (papers, official records, or pubs)
• Physical Description
• Location (room)
• Range (of shelving)
• Section (in range)
• Comments

 RDA Database:
• Record Group Number (linked to authority controlled names)
• Sub Group Number (linked to authority controlled names)
• Sort Number (series number of item in this subgroup)
• Series Title
• Disposal indicator (e.g. destroy, retain in office, transfer to archives, etc)
• Physical type (e.g. papers, microfilm)
• Annual Accumulation or volume (for a "dead" series–dead is indicated in the

disposal indicators)
• Authorization Year



• Authoriziation Number (taken together, these two fields are primary key)
• Beginning Date of Records
• Ending date of records (left open for live series)
• Action Period (date after which materials may be destroyed or other action taken)

Control Card Database:
This database consists of several linked tables.  See the relationship table.
UAControlCard Table

• Record Group Number (linked to authority controlled names)
• Sub Group Number (linked to authority controlled names)
• Series Number (first three fields are the primary key)
• Record SeriesTitle
• InclusiveDates
• FirstDate
• LastDate
• Volume
• Description
• FindingAidPages
• FindingAidURL
• Arrangement
• DateReceived
• Type (Personal Papers, Offical Records, or Publications)
• Status (Physical Characteristics of the series)

SubjectDescriptors
This is a lookup table.  It contains our controlled vocabulary subjects which are linked to

a six digit code

SubjectIndex
• Record Group Number (linked to authority controlled names)
• Sub Group Number (linked to authority controlled names)
• Series Number (first three fields are the primary key)
• SubjectID (six digit code linked to Subject Descriptors table)

RGNumber
A lookup table with two fields, RGNumber, and RGTitle providing the record group

name for each record group number.

SGNumber
A lookup table with three fields, RGNumber, SGNumber, and SGTitle providing the

subgroup name for each subgroup number.

Volume Snapshot and Old Annual Report Volumes
These are dummy tables created during the running of the macros to produce our annual

report statistics.  They take a snapshot of data at yearly interval, to allow for
comparison next year.



4.  Access Mechanisms

Our main access mechanism, as discussed above, is a web accessible database which reads the
data from our SQL Control Card database.  The database can be searched at
http://web.library.uiuc.edu/ahx/uaccard/.  This database runs on a IIS platform and uses Active
Server Pages (ASP) to dynamically generate the webpages.  The ASP mechanism supports
several functions, including simple and advanced searches as well as browsing by either our
controlled subjects or by administrative units.  In addition, the records include Dublin Core in
HTML meta tags, so that the records can be easily harvested under the OAI protocols.  The
browse by unit function has been very popular with staff members who understand the controlled
vocabulary and the record group systems.  Records can also be directly retrieved by entering the
series number.  Where a supplementary finding aid exists, a link is automatically generated by
the ASP code.  Linked finding aids are mainly in PDF format, but EAD and HTML finding aids
are also included.  We are very happy with this system and do not anticipate making any
substantial changes to it in the near or medium term future (and probably not in the long term). 
It has been a very robust access mechanism, is flexible, and has received much praise from staff
and users.

In addition, we have other access mechanisms available via our website, including subject
specific resource guides and a separate list of EAD projects.  Weak points in our access system
include the lack MARC-AMC records, but given institutional resources I do not see full
cataloging for these records as a wise investment at this time.  (It is likely that our library will
purchase Encompass software from Endeavor, which will allow the records to be aggregated
with MARC records and searched via a common interface).  The system could also benefit from
rigorous application of APPM, but again that is not likely given institutional resources and
priorities.



Appendix 1: Records Disposal Authorization Database EntryForm



Appendix 2: Accession Register Entry Form



Appendix 3: Typical Supplementary Finding Aid

25/1/2
Admissions and Records
Dean's Office
Subject File, 1922-40, 1945-65, 1869-1996

Box 1:  Tuttle Correspondence; Budget and Fees, 1946-56

Tuttle Administrative Correspondence:
Administrative Correspondence, General, 1949-56
Admissions, Regulations by Semester, 1947-49
Admissions, Transfers, 1947
Aircraft Maintenance, 1949
Announcements to the Office Staff, 1948-54
Chemistry Department, 1947-53
Chicago, University of, 1948-56
Closings, Limits to Admissions, 1946-50
College of Commerce & Business Administration, 1952-54
Cooperative Admissions Centers, 1947
Education, College of, 1947-55
Engineering, College of, 1950-56
Fees, 1948-56
Fine and Applied Arts, College of, 1955-56
Foreign Students, 1950-53
Graduate College, 1947-56
Graduate College, re: Special Status, 1947-55
Journalism, School of, 1947-51
Library School, 1947-51
Mathematics, Department of, 1952
Military Service, 1950-56
Non-Residents, 1948-51
Permits Issued, 1947-56
Physical Education, 1947-55
Pre-Medicine and Pre-Dentistry, 1948-53
Pre-Nursing, 1949-54
Progressive Admissions, 1947-53
Selective Service, 1951
Special Services for War Veterans, 1949-52
Staff Letters, General, 1950-54
Summer Session, 1951
Veterinary Medicine, 1948-53

Registrar's Budget Material, 1922-40
Budget: 

1948-49
Appendix 4: Collection-Level Database Entry Form





Appendix 5: End of Processing Workflow

End of Processing Workflow

• Processor types finding aid or provides to typist to type.

• Processor prepares label list.

• Processor enters changes to Control Card database:
• If creating new record Series, input all data to database, including subject descriptor numbers for

existing subjects.  Print draft Control Card/IWS.  If suggesting new subjects, write them on form
(do not attempt to enter)

• If modifying an existing series, print a draft of the old record from database, and hand write
changes on the form, including subject descriptors and numbers. Input changes only after draft
Control Card/IWS returned with supervisor approval.

4. Processor submits all paper work to supervising archivist in one packet—draft Control Card/IWS, SFA,
and label list.

5. Supervisor reviews, suggests changes, and initials draft Control Card.  If new subjects are to be defined,
supervisor makes copy of control card and routes to University Archivist who enters them into the database
on occasional basis.

6. Supervisor returns all material to processor with comments and changes.

7. Processor:
• Prints two copies of final SFA, routes to LTA for creation of cover, filing, and moving to

Illiarch directly on file server.
• Routes Draft control card/IWS to LTA for filing.
• Prints final copy of control card and files or routes to LTA  for filing.
• Prints SFA to PDF file and posts on website–see below.  Or updates HTML or EAD

version.
• Submits label list to typist and affixes labels when returned.
• Shelves series or notifies supervisor for shelving.

8. Person shelving the series enters the location in location guide and/or provides to Bob for entry into
main location guide at UA

9. LTA changes unprocessed volume in Accession Register database to 0.0.

Posting PDF Files to the website

Posting  a finding aid to the website is the responsibility of the processor:
• While document is active, hit print button on tool bar or file menu.
• Under the box for current printer, select WIN2PDF.  Hit the Print Button.
• when prompted for file name, enter c:/pdf/RGSGRSN.pdf using our normal file naming

convention.
• Go to the Windows Desktop and open the shortcut to the PDF directory.
• Drag the file to the shortcut for uasfa on libgrenlil on the windows desktop.
• Enter the URL in the URL field of the Control Card database in the following format:

../uasfa/xxyyzzz.pdf where xxyyzzz is the record series number.



Appendix 6: EAD Markup Interface in NoteTab Pro



Appendix 7: Website Interface for Control Card Database



Appendix 8: Table Relationships in SQL "Control Card" Database



Appendix 9: Control Card Database User Documentation

Control Card Database
User Documentation

As a part of your work as a graduate or undergraduate assistant at the University Archives, you
will be asked to create “control cards” or summary records for each record series that is
processed or added to.

• File Location: Database files are edited via a Microsoft Access database stored in the
following directory: G:\Archives\Ahxasst\Accessdb\Uacc.  The database is most easily
accessed through the desktop shortcut placed on each machine.

• Important Note: When you are working in this database, you are making changes to the
record copy of our files.  Any changes made to the contents of the database are
automatically recorded and become immediately accessible on the webpage.  Be very
careful when editing control cards since the only backup is on a tape drive accessible
through the systems office.  Be particularly careful not to accidentally change record
group, subgroup, or series numbers or to overwrite existing records, especially location
information.

• Modifying or Adding a Database Record

• Click the Icon “UA Control Card System” on the Windows Desktop.  Or Click on
the MS Access Icon located on the toolbar and open the file “uaccard.mdb”

• To edit or create a record:
• Click the <Forms> tab in Access.
• Doubleclick <Edit or Create a Control Card>.
• You will be prompted to enter in succession the:

• RG#
• SG#
• Series#

• If the record series is not found, the record series number does not exist. 
You may create a new record series if that is your intention.  (Before
assigning a record series number, you must submit the recommended
numbers to an archivist for approval.)

• The record can now be edited or created.  The Record Group and
Subgroup Fields are automatically added by the system based on the
numbers added in the RGNumber and SGNumber fields.  Therefore you
must be very careful to make sure that the correct numbers are used.

• If creating a new record series, fill in all fields (URL is not required).
• If the series has an on line finding aid or associated website, enter the url

in the FindingAidUrl field.  If it is a PDF document, post the PDF
document to the website–see separate instructions.



• To move from one field to the next, use <TAB>.
• When entering dates, do not use the “19" designation before the second

half of an inclusive date.  1972-89 is correct NOT 1972-1982.  Use a four
digit date (YYYY) in the BeginDate and EndDate fields.  Format does not
matter in the Dates Received field.

• If you are assigning subject terms, use the six digit code.  If you wish to
suggest a subject term which does not have a six digit code, hand write the
term on the draft control card which is submitted to an archivist for
approval.

• If you shelve the record series, update the location information in the table
or add a new location using the “Add Location” button.

• To save an updated or new record, close the record.  The changes are
automatically recorded and become immediately accessible on the web.

• When finished with all updates, exit the database and all changes are
recorded automatically.

• Before printing updates to a control card, Print a draft of the control card for
review by the archivist by clicking the “print draft” button on the form; a draft
control card will be printed at the Windows default printer for the machine on
which you are working (LaserJet in UA, other local printer at ARC) 

• When supervisor has given approval, print a final copy of the card by clicking the
print final button.  When prompted to insert cardstock, click ok, go to the
computer, and insert cardstock (half sheets are acceptable.)



Appendix 10: Control Card Database Technical Documentation

Control Card Database
Technical/Administrative Documentation

Overview

1. Database Structure.  The University Archives and ALA archives databases consist of
two distinct elements:

• SQL Server Database: These are the actual physical databases.  They are
stored on the LIBGRMAKOSH server.

• Access Database.  The Access database contains ODBC links to the SQL
databases and provides input forms, standard queries and reports for the
data in the SQL databases.  These forms are parallel between the UA and
ALA databases.

2. SQL Administration.  The SQL database design (i.e. the linked ODBC tables in Access)
can only be altered by personnel in the systems office or someone with an installation of
SQL server and proper permissions.  If fields need to be added to the tables in the
database or the properties of those tables or fields altered in any way, we must contact the
systems office to arrange for this work. 

3. Access General Administration.  Current database setup hides most of the tables, forms
and reports so that users cannot modify them.  In order the view the hidden tables, forms
and reports which are discussed below, follow these instructions: On the Tools menu,
click Options.  Then click the View tab.  Under Show, select the Hidden Objects check
box. Microsoft Access displays hidden objects with dimmed icons.  When you are done
making changes, deselect the check box so the controls are hidden again.

If a new computer is installed, an ODBC data connection needs to be configured on the
machine so that users can connect to the database.  This is done through the settings
(Control Panel) page which is available under the Windows Start button.  After clicking
the ODBC data sources icon, select the “system DSN” tab.  Click the add button, then
provide a name for each database–“alacards” and “uaccards” as appropriate.  These
names must be exactly as shown here.  For “Server to connect to” select
LIBGRMAKOSH.  Click Next.  Click thru the next screen.  On the following page, select
the appropriate default database–(ALACCARD or UACcard).  Click finish and if desired
test the data source.  If the test is successful, click OK.  Then test the database.

To allow for disaster recovery, copies of each database have been placed on the Illiarch



directory.  However, this does not back up the data, only the forms, queries, etc.  If the
data is somehow lost from the SQL database, it can only be restored from the systems
office backup tapes for LIBGRMAKOSH.

4. Access "Tables" Tab: The database consists of the following tables which are linked via
a series of relationships:

• UAControlCard–Linked ODBC table, contains main control card data
• RGNumber, SGNumber–Linked ODBC tables, contain authority control

for record group and subgroup terms; fields are linked to parallel fields in
UAControlCard table

• Location–Linked ODBC, contains location records for each RS; linked to
UAControlCard

• SubjectIndex–Linked ODBC, contains subject descriptor ID numbers
matched to record series numbers, linked to UACCARD

• SubjectDescriptors–Linked ODBC, contains authority control descriptor
terms.

• OldAnnualReportVolumes–Access table, contains volume statistics
generated during annual report from previous year.  This table must be
updated annual each year after running the annual report macro to allow
for generation of accurate statistics next year.  See below.

• Volume Snapshot–Access table, is automatically updated during running
of the annual report macro.  After annual report is completed, data must be
manually copied to the OldAnnualReportVolume table.

5. Access Queries Tab Contains a variety of queries, some of which can only be run when
the "Edit or Create a Control Card" form is active.   A description for each query's
function is given on the Query tab.

6. Access Forms Tab.  Most forms are described in the description.  Only Edit or Create a
Control Card is visible to the user.  The location and subject data can be updated using
the buttons, and entire records can also be deleted from the subforms by right clicking
them.  The other forms are subforms used on the main form.  They take lookup values
based on the main form as parameters to allow for the updating of records in the related
tables.

7. Macros Tab.  The macros are identified in the descriptions.  There are macros used in
the forms and a longer macro which exports end-of-year data for compilation of the
annual report.

Performing Common Administrative Tasks:

Before completing any of these tasks or modifying the database, you must click “show hidden
controls” on the View tab under the Options page of the Tools Menu.

1. Printing Location Guide: Under Queries Tab, run “LocationGuideQuery”.  Once the
query is active, Export the query as a delimited text file or Excel spreadsheet using “Save
as/Export” under the file menu.  The exported text file may then be opened in Excel and



formatted for printing.

2. Printing Subject Guide: Under forms Tab, run “Subject Guide”.  The guide can then be
printed.

3. Managing Subject Descriptors: New subject descriptors can be assigned a six digit
code using the “Define New Subjects” form on the forms tab.

4. Producing Annual Report Data: Annual report data is generated by a series of queries
defined under the queries tab.  These queries compare data in the current UAControlCard
Table to data in the OldAnnualReportVolumes table.   The queries are run en masse by
clicking the “Annual Report” macro under the Macros Tab.  Th first part of this macro
runs each query and exports the results to a series of text files stored in the export
directory for each database:

decreased.txt–shows record series where volume decreased
increased.txt–shows record series where volume increased (i.e. record series with

additions)
new.txt–shows newly processed record series
TypeSum.txt–provides total volume by Type of material (Papers, Pubs, etc)
TypeDetail.txt–provides volumes by type of material for each record group
VolumesByLocation–provides total volume for processed material by location

The second part of the query copies current volumes to the “Volume Snapshot” table. 
(When the Macro pauses to say “Delete xxxx records.  Continue?” click Yes.  The
records are being deleted from a temporary table.)  In order to allow for production of
annual report statistics next year, the records from the “Volume Snapshot” table MUST
by substituted for the current values in the “OldAnnualReportVolumes.” table by
deleting the current values and pasting the new values in.  If desired, the Old annual
report volumes could be exported first to a delimited text file to allow for a permanent
record of University Archives yearly holdings.

Once the data has been exported to the text files, in can be imported to a spreadsheet or
wordprocessor to allow for manipulation and formatting.

Webpage Maintenance

The website is run by Active Server Pages (ASP) code which queries the main Database to
return result sets using Structured Query Language (SQL).  Basic changes to the formatting of
the pages (fonts, text size, etc) can be made by editing the CSS stylesheet “style.css” which is
stored in the same directory as the default files.  More substantial formatting changes can be
made by editing the html in the individual .asp pages.  If the ASP for SQL code is broken,
systems office help may be solicited.  

In addition, one common task needs to be performed whenever a new or replacement computer
is added to the University Archives Staff computer.  Part of the ASP code in the
UAControlCard.asp file outputs the current locations for staff computers by testing the IP



address of the connecting computer.  The IP address for any computer where locations should be
show should be added to the following snippet of code:

 host=Request.ServerVariables("REMOTE_ADDR")
' Enter IP addresses here for computers that should show locations

if host="130.126.33.47" or host="130.126.32.64" or host="130.126.32.188" or
host="130.126.33.50" or host="130.126.33.49" or host="130.126.32.153" or
host="130.126.35.239" or host="128.174.3.250" or host="128.174.3.249" or
host="128.174.3.248" or host="128.174.3.247" or host="130.126.33.86" then
If Not lc.EOF then
[. . .]



Appendix 11: Reference Card, Front and Back



Appendix 12: Reference Statistics Report


